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1. Version Management 

Version Update Description Table 

Version Content Date 

V1.4 
1. Added: PXN-45 / PXN-60 /PXN-90 Interface Description 

2. Added: All-New Series LED light Description 

03/17/2026 

V1.3 

1. Added: Include a chapter on Using the Accompanying Trigger 

Board 

2. Added: 10 MHz Reference Clock Input/Output Section 

3. Added: External Interface Description section for the All-New 

SAN Series Instruments 

4. Added: GNSS Usage Section for the All-New SAN Series 

Instruments 

5. Added: GPIO Usage Instructions Section 

02/05/2026 

V1.2 
1. Modified: Renamed MUXIO to AUXIO 

2. Modified: Description modification 

11/10/2025 

V1.1 

1. Added: Added a GNSS version description section, 

distinguishing the connection steps for the old and new GNSS 

modules 

2. Added: Added a section on outputting and Viewing the 

Intermediate Frequency Signal 

3. Added: Added: a section on OTG Connection 

09/04/2025 

V1.0 1. Initial Version 
07/30/2025 
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2. System requirements 

SA/NX series are core instruments, and their spectrum analysis software must be installed on 

a host computer. The recommended host system requirements are listed in the table below: 

The table provides only basic recommended configurations. For systems below these 

specifications, please verify with actual test results. 

Table 1 System Requirements 

Operating System Windows 11/10/8/7, (requires VS2019 C++ redistributables) 

Ubuntu 22.04/20.04/18.04, Debian 12/11/10, Raspberry Pi OS 64bit 

Architecture Windows: x64, AArch64 (NX instruments only) 

Linux: x64, AArch64 

Processor Windows: Intel i3 or higher; AArch64 tested only on Snapdragon 8CX 

Gen2 

Linux: Tested on Raspberry Pi 4B, PK3399, PK3588, etc. 

Memory 4 GB or higher 

Storage For IQ signal recording: Ensure sustained write speeds exceed 400 

MBytes/s 

Data Interface USB 2.0 or USB 3.0 (USB 3.0 recommended) 

IQ recording bandwidth and duration are limited by interface bandwidth 

Display Minimum resolution: 1280 × 768 pixels 

Other Notes Some antivirus software may cause system instability 
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3. SA Series Quick Start Guide 

This chapter is a quick start guide to the SA Series, featuring safety instruction, using 

instruments, running the software and external interface description. 

3.1 Safety Instruction 

 Power Adapter Selection 

1. Adapter Selection: Prefer the original manufacturer-provided power adapter. Alternative: 

Select a compatible adapter according to the product manual. 

2. DC Power Supply Requirements: 

⚫ Voltage: 5 V ± 0.25 V (i.e., 4.75 V - 5.25 V) 

⚫ Current: ≥ 3 A for new SAN series; ≥ 2 A for other models 

⚫ Ripple: < 200 mVpp 

Note: Failure to comply with these specifications may result in device damage. Please strictly 

follow the product manual requirements. 

 RF Input 

For maximum damage input power (CW) and maximum DC voltage, please refer to the product 

manual, and strictly prohibit exceeding the limits to avoid irreversible damage to the instrument. 

3.2 Using SA Series Instruments 

 Connecting the Device 

1. Connect the instrument's power port to the power adapter using the Type-C cable and 

plug it into the socket; 

2. Connect the instrument's data port to a computer or embedded device using a Type-C 

cable, USB 3.0 is recommended for best performance. 

Note: It requires for 3 seconds for SA Series instruments operating normally after power-on. 

 

Figure 1 SA series connection diagram 
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 Driver Installation (Windows) 

The following part presents the instructions for driver installation using Windows 10 x64 as an 

example. Note: Windows 11 is compatible with Windows 10 drivers. 

1. Check the computer system information, confirm the system version and number of bits; 

2. Open the "Windows\HTRA_Driver\Win10_x64" folder in the supplied USB flash; 

3. Right-click the "Install_Driver.bat" file and select "Run as administrator" from the pop-up 

menu to initiate driver installation; 

 

Figure 2 Installation of driver 

4. The terminal appears "USB Driver Installation Succeeded" prompt, it means that the driver 

installation success. 

 Driver Installation (Linux) 

The following will be an example of installing the driver in Ubuntu 18.04. 

1. Copy the "Linux" folder from the supplied USB flash to the system; 

2. Right-click on the "Linux/Install_HTRA_SDK" folder and select "Open in Terminal" to open 

the terminal; 

3. In the terminal type sudo sh install_htraapi_lib.sh and enter, according to the prompts to 

enter the current user password, and then enter again to confirm the installation; 

4. After connecting the instrument, type lsusb in the terminal, such as ID:6430, ID:04b5 or 

ID:367f, it means the driver installation is successful. 

 

Figure 3 Checking Whether the Instrument Is Properly Connected in Linux 
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3.3 Running the Software 

 Windows System 

By default, the instrument is properly connected and the driver is installed. 

1. Copy the software folder in the "Windows" directory of the supplied USB flash drive to the 

desktop or other directories of your computer; 

2. Enter the "\bin" folder in the software directory, run the executable program, and the 

spectrum display interface will be as follows. 

 

Figure 4 Initial software display 

 Linux System 

By default, the instrument is properly connected and the driver is installed. GCC version 4.8 or 

above. GLIBC version 2.17 or above. 

Software download link: https://www.harogic.com/software-for-harogic-sa-nx-series-

spectrum-analyzer/ 

1. Copy the compressed package of the software for the corresponding architecture from the 

supplied USB flash drive to the Linux system and extract it; 

2. Navigate to the directory containing the software installation package, right-click on a blank 

area of the folder, and select “Open in Terminal”; 

3. In the terminal, run "sudo sh ./install.sh", then enter the password as prompted to complete 

the installation; 

4. After installation is complete, double-click the desktop software icon or enter "./app.sh" in 

the terminal to launch the software. 

https://www.harogic.com/software-for-harogic-sa-nx-series-spectrum-analyzer/
https://www.harogic.com/software-for-harogic-sa-nx-series-spectrum-analyzer/
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3.4 External Interface Description 

 SAN Series and SAM Series 

 

Figure 5 SAN and SAM Series Instrument Interface Description 

Table 2 SAN Series and SAM Series Interface Description  

Pin Interface Name Description 

1 RF Input SMA (F), Input Impedance 50 Ω 

2 RF Output SMA (F), Output Impedance 50 Ω (Available with "Built-in 

Signal Source" option) 

3 Reference Clock Input MCX (F), Amplitude ≥ 1.5 Vpp, Input Impedance 330 Ω. 

Supports Sine, Square, Peak Clipping Sine 

4 Power Port Instrument Charging Port, Type-C 5 V 2 A 

5 Data Port Type-C, USB 3.0 Recommended (USB 2.0 compatible, 

but bandwidth limited) 

6 Multifunctional AUXIO For detailed description, please refer to the table below. 

Table 3 Description of Multi-function AUXIO PIN Interface of Port 6 (Illustration direction 

from left to right) 

Pin Name Direction Level Standard Meaning 

A1 GND / / Ground 

A2 NC / / / 

A3 EXT_TRG-IO1_F I 3.3 V External trigger input, 

up to 500 times/s. 

A4 VEXT O / Power Output, 5 V 

A5 GND / / Ground 
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A6 USART6_TX_F / / / 

A7 USART6_RX_F / / / 

A8 NC / / / 

A9 VEXT O / Power Output, 5 V 

A10 EXT_TRG-IO2_F O 3.3 V External trigger output 

A11 USART6_IT_F / / Reserved 

A12 GND / / Ground 

 SAE Series and SAN-400 Series 

 

Figure 6 SAE and SAN-400 series instrument interface description 

 

Table 4 SAE Series and SAN-400 Interface Description 

Pin Interface Name Description 

1 RF Signal Input SAE-90 series instruments: SMA (F), input impedance 50 Ω 

SAE-200/SAN-400 series instruments: 2.92 mm (F), input 

impedance 50 Ω 

2 Analog IF output MMCX (F), maximum output power -25 dBm, output 

impedance 50 Ω 

3 Reserved interface / 

4 Reference Clock 

Input 

MMCX (F), Amplitude ≥ 1.5 Vpp, Input Impedance 330 Ω 

Supports Sine, Square, Peak Clipping Sine 

5 Multifunctional 

AUXIO 
For detailed description, please refer to the table below. 
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6 Heat dissipation 

vent 
/ 

7 Data port Type-C, USB 3.0 Recommended (USB 2.0 compatible, but 

bandwidth limited) 

8 Power port Instrument Charging Port, Type-C 5 V 2 A 

Table 5 Description of Multifunctional AUXIO PIN Interface of Port 5 (Illustration direction 

from left to right) 

Pin Name Direction Level Standard Meaning 

1 EXT_TRG_IO1 I 3.3 V Trigger input, up to 500 times/s 

2 EXT_TRG_IO2 / / Reserved 

3 EXT_TRG_IO3 O 3.3 V Trigger output 

4 GND / / Ground 

5 LFADC_INA I / Low Frequency ADC Input 

6 3V3D O / Power output, 3.3 V Output 

7 USART9_RX / / / 

8 GND / / Ground 

9 USART_TX / / / 

10 NC / / / 

11 NC / / / 

12 NC / / / 

13 GND / / Ground 

14 REFCLK_OUT O / Reference clock output, can 

output 10 MHz standard clock 

signal 
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 All-New SAN Series 

 

Figure 7 All-New SAN series instrument interface description 

Table 6 All-New SAN Interface Description 

Pin Interface Name Description 

1 RF Signal Input N (F), impedance 50 Ω 

2 GNSS Antenna Input SMA (F) 

3 Power Port Instrument Charging Port, Type-C 5 V 3 A 

4 Data Port Type-C, USB 3.0 Recommended (USB 2.0 compatible, 
but bandwidth limited) 

5 Reference Clock Input MMCX (F), 10 MHz, Amplitude ≥ 1.5 Vpp, Impedance 330 

Ω, Supports Sine, Square, Peak Clipping Sine 

6 Reference Clock Output MMCX (F), 100 MHz, Amplitude ≥ 0.3 Vpp, 

programmable on / off 

7 Analog IF output MMCX (F), maximum output power -25 dBm, output 

impedance 50 Ω, frequency 312.5 MHz ±  50 MHz 

8 Multifunctional AUXIO For detailed description, please refer to the table 

below. 

9 LED Indicator Green: Normal operation 

Red: Abnormal status 

Yellow: Remote update failed 
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Table 7 Description of Multifunctional AUXIO PIN Interface of Port 8 (Illustration direction 

from left to right) 

Pin Name Direction Level Standard Meaning 

1 TRG IN I 3.3 V Trigger input, maximum 

frequency response 500 

times/s. 

2 TRG OUT O 3.3 V Trigger output 

3 Reserved / / Reserved 

4 GND / / Ground 

5 PPS OUT O 3.3 V XPPS output 

6 3.3V O 3.3 V Power output, 3.3 V output 

7 USRAT RX / 3.3 V / 

8 GND / / Ground 

9 USART TX O 3.3 V / 

10 Reserved / / Reserved 

11 Reserved / / Reserved 

12 Reserved / / Reserved 

13 GND / / Reserved 

14 Reserved / / Reserved 
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4. NX Series Quick Start Guide 

This chapter is a quick start guide to the NX Series, featuring safety instructions, instrument use, 

runtime software and external interface descriptions. 

4.1 Safety Instructions 

  Power Adapter Selection 

1. Primary Option: Always use the original manufacturer-provided power adapter. Alternative: 

If unavailable, select a compatible adapter with specifications matching those outlined in 

the product manual. 

2. DC power supply requirements: voltage: 12 V (9 V to 12 V), current: minimum 2 A; peak ripple 

maximum 200 mVpp. 

Note: Violation of specifications may result in damage to the instrument, follow the product 

manual strictly. 

 RF Input 

For maximum damage input power (CW) and maximum DC voltage, please refer to the product 

manual, and strictly prohibit exceeding the limits to avoid irreversible damage to the instrument. 

4.2 Using the NX Series Device 

 Connecting the Device 

1. Connect the instrument's power port to the power adapter using the Type-C cable and plug 

it into the socket. 

2. Use a network cable to connect the Gigabit network port (LAN2) of the instrument to the 

network port of the computer or embedded device for optimal performance (100 Mbps for 

LAN1 and 1 Gbps for LAN2). 

Note: NX series instruments need about 40 s to complete the self-start after power on, please 

wait patiently. Long press the power button for more than 5 seconds to switch off the 

instrument. 
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Figure 8 NX series connection diagram 

 Configuring the Network 

NX Series Instrument Network Configuration Instructions: 

▪ IPv4 address: "192.168.1.100" (not modifiable), "192.168.3.100" (modifiable) 

▪ Subnet mask: "255.255.255.0" 

▪ Bridge mode: enabled (LAN1/LAN2 logical interworking) 

▪ Network access: via LAN1 (100 Mbps) or LAN2 (1 Gbps) 

The host computer needs to set the IP of the same network segment as the NX instrument (e.g. 

"192.168.1.X" or "192.168.3.X") in order to be used normally, and the IP address of the host 

computer can be configured as follows: 

1. Open "Settings" -> select "Network & Internet" -> select "Ethernet"; 

2. Enter Ethernet, find the IP section and click "Edit"; 

3. Select "Manual" mode and enable "IPv4", set the IP to "192.168.1.2" and the subnet mask to 

"255.255.255.0". Set the IP to "192.168.1.2" and subnet mask to "255.255.255.0"; 

4. Open the command prompt (Win + R -> enter "cmd"), the implementation of the command 

"ping 192.168.1.100", if you receive the following reply, it means that the network connection 

is successful. 

 

Figure 9 Test instrument network connectivity (ping command) 
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4.3 Running the Software 

Please refer to the Running the software section in SA Series Quick Start Guide chapter. 

4.4 External Interface Description 

 NXN and NXM Series 

 

Figure 10 NXN and NXM Series Instrument Interface Description 

Table 8 NXN Series and NXM Series Interface Description 

Pin Interface Name Description 

1 Reference Clock Input MCX (F), Amplitude ≥ 1.5 Vpp, Input Impedance 330 Ω. 

Supports Sine, Square, Peak Clipping Sine 

2 RF Output SMA (F), Output Impedance 50 Ω (Available with "Built-

in Signal Source" option) 

3 RF Input SMA (F), input impedance 50 Ω 

4 USB Type-C, USB 2.0 

5 GNSS antenna input MMCX (F) 

6 Trigger output MMCX (F), 3.3V CMOS 

7 Trigger input MMCX (F), 3.3V CMOS, high-impedance input, max 

trigger rate 500 times/s 

8 Reference Clock Output Provides high quality 10 MHz clock signal when 

equipped with internal DOCXO 

11 12 13 Reserved Interface / 

9 Multifunctional AUXIO For a detailed description, please refer to Table below. 
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10 4G Antenna Input MMCX (F) 

14 Instrument Switch Switch the instrument on/off. The instrument starts up 

automatically on first power-up, eliminating the need to 

manually press the switch. During power-up, the 

instrument can be switched off and on again with a 

switch. 

15 Reserved Interface / 

16 Power Port Type-C PD3.0 12 V 2 A/9 V 2 A 

17 LAN1 Fast Ethernet Port (100 Mbps) 

18 LAN2 Fast Ethernet Port (1 Gbps) 

Table 9 Description of Multifunctional AUXIO PIN Interface of Port 9 (Illustration direction 

from right to left) 

Pin Name Direction Level Standard Meaning 

1 GPIO0 / / Reserved 

2 TRG IO2 / / Reserved 

3 GPIO1 / / Reserved 

4 GND / / Ground 

5 GPIO2 / / Reserved 

6 3V3/5VIN O / Power output, 5 V output 

7 GPIO3 / / Reserved 

8 GND / / Ground 

9 USART_TX_FP / / Reserved 

10 11 12 NC / / / 

13 GND / / Ground 

14 REFCLK_OUT_FP O / Reference Clock Output, 

Outputs 10 MHz std. clock 
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 NXE Series and NXN-400 

 

Figure 11 NXE and NXN-400 series instrument interface description 

Table 10 NXE and NXN-400 Series Interface Description 

Pin Interface Name Description 

1 RF Input NXE-90 series instruments: SMA (F), input impedance 50 Ω  

NXE-200/NXN-400 series instruments: 2.92 mm (F), input 

impedance 50 Ω 

2 USB Type-C, USB 2.0 

3 Multifunctional 

AUXIO 

For detailed description, please refer to the table below. 

4 GNSS Antenna Input MMCX (F) 

5 Trigger Output MMCX (F), 3.3V CMOS 

6 Trigger Input MMCX (F), 3.3V CMOS, high-impedance input, max trigger 

rate 500 times/s 

7 Reference Clock Input MMCX (F), Amplitude ≥ 1.5 Vpp, Input Impedance 330 Ω. 

Supports Sine, Square, Peak Clipping Sine 

8 4G Antenna Input MMCX (F) 

9 Analog IF Output MMCX (F), Max Output Power -25 dBm, Output Impedance 

50 Ω 

10, 11 Reserved Interface / 

12 Instrument Power 

Switch 

Switch the instrument on/off. The instrument starts up 

automatically on first power-up, eliminating the need to 

manually press the switch. During power-up, the instrument 

can be switched off and on again with a switch. 

13 Reserved Interface / 
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14 Power Port Type-C PD 3.0 12 V 2 A/9 V 2 A 

15 LAN1 Fast Ethernet Port (100 Mbps) 

16 LAN2 Fast Ethernet Port (1 Gbps) 

Table 11 Pin 3 Multi-function AUXIO Pin out Description (Pins ordered right-to-left in 

diagram) 

Pin Name Direction 
Level 

Standard 
Meaning 

1 GPIO0 / / Reserved 

2 TRG IO2 / / Reserved 

3 GPIO1 / / Reserved 

4 GND / / Ground 

5 GPIO2 / / Reserved 

6 3V3/5VIN O / Power Output, 3.3V Output 

7 GPIO3 / / Reserved 

8 GND / / Ground 

9 USART_TX_FP / / Reserved 

10 SYNC_RXRFLO / / Reserved 

11 SYNC_ADCCLK / / Reserved 

12 SYNC_RXIFLO / / Reserved 

13 GND / / Ground 

14 REFCLK_OUT_FP O / Reference Clock Output, Outputs 

10 MHz std. clock 
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5. PX Series Quick Start Guide 

This chapter is a quick start guide to the PX Series, featuring safety instructions, instrument use 

and external interface descriptions. 

5.1 Safety Instruction 

 Safety Rules 

▪ Appearance check: make sure that the instrument is in good condition and free from 

damages 

▪ Accessory check: no damage to power cord, adapter 

▪ Ventilation check: fan vents are kept clear 

▪ Environment check: the instrument is dry and free of moisture and condensation, and the 

ambient temperature meets the requirements of the product specification 

▪ Operation monitoring: Ensure that the fan is working properly and that the working 

temperature and humidity are in accordance with the product specifications 

▪ Connection specification: all external interfaces are correctly connected and the RF input 

signal level meets the requirements of the product specification 

▪ Power management: maintains battery at >5% of capacity 

▪ Storage requirements: the instrument is completely switched off, and the temperature and 

humidity of the storage environment meets the requirements of the product specification 

Note: Abnormal handling: Any damage or malfunction is found, please contact the official after-

sales service in a timely manner 

Note: Safety warning: It is strictly forbidden to open the shell of the instrument (to prevent 

electric shock) 

 Power Adapter Selection 

Adapter Selection: Prefer the original matching power adapter. Alternative: Refer to the 

product manual to select the adapter with matching specifications. 

Note: PXZ instruments must use the original factory-mounted power adapter; third-party 

alternatives are not supported. 

Note: Violation of specifications may result in damage to the instrument, follow the product 

manual strictly. 
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 RF Input 

For maximum damage input power (CW) and maximum DC voltage, please refer to the product 

manual, and strictly prohibit exceeding the limits to avoid irreversible damage to the instrument. 

 Replacing the Power Adapter 

PX series instruments support the replacement of batteries, if you need to replace, please 

contact the official after-sales service channel to deal with, do not disassemble the instrument. 

5.2 First Use of the Instrument 

The instrument has been transported over a long distance, the battery power may be below 5%, 

it is recommended to connect the supplied power adapter before the first use, and then switch 

on the instrument. 

 Switching the Instrument On and Off 

The instrument is switched on/off by the power button on the top of the instrument. When the 

instrument is switched on, the power indicator light is on; when it is switched off, the power 

indicator light is off. 

 Charging Indicator 

When the instrument is connected to the power adapter, the charging status light flashes green 

to indicate that it is charging. When the battery is fully charged, the charging indicator light will 

change to a green constant light. 

 Running the Software 

Press the power button, the instrument will enter the desktop environment after powering on 

and start the software automatically. 
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5.3 External Interface Description 

 PX Series 

For ease of user operation, all interfaces of the instrument are integrated on the top panel. 

Please refer to the table below for detailed descriptions of each interface. 

 

Figure 12 PX series instruments upper board interface description 

Table 12 PX Series Interface Description 

No Interface Name Description 

1 Power Button On/Off instrument 

2 Charging port Instrument charging port, USB PD3.0 20 V 3.25 A, please 

connect the power supply according to the 

instrument's required operating voltage 

3 Micro HDMI For extended display 

4 USB3 USB interface: USB3 is USB 3.0 interface, USB1 and 

USB2 are USB 2.0 interface. This interface connects to 

external storage devices, USB keyboards, or mice. It 

can also be used to connect a driver-free Hub with an 

Ethernet port, allowing the instrument to be remotely 

controlled by a PC via network cable 

5 USB2 

6 USB1 

7 Audio Output 3.5mm headphone jack. Volume can be adjusted via the 

menu: "System" -> "Device" -> "Volume." 

8 Multifunctional AUXIO For detailed description, please refer to the table 

below. 

9 Charging Indicator Green flashing means charging, green always on means 

full. 

10 Analog IF output MMCX (F), max. output power -25 dBm, output 

impedance 50 Ω 

11 Trigger Output 3.3V CMOS 
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12 Trigger Input MMCX (F), 3.3V CMOS, high-impedance input, max 

trigger rate 500 times/s 

13 Reference Clock Input MMCX (F), Amplitude ≥ 1.5 Vpp, Input Impedance 330 Ω. 

Supports Sine, Square, Peak Clipping Sine 

14 GNSS Antenna MMCX (F), amplitude 1.5Vpp, input impedance 330 Ω 

15 RF Signal Input PXE-200: N (F), input impedance 50 Ω 

PXN-400: 2.4mm (M), input impedance 50 Ω 

Table 13 Pin description for AUXIO interface 8 (from left to right) 

Pin Name Direction 
Level 

Standard 
Meaning 

1 GPIO0 / / Reserved 

2 TRG IO2 / / Reserved 

3 GPIO1 / / Reserved 

4 GND / / Ground 

5 GPIO2 / / Reserved 

6 3V3/5VIN O / Power Output, PXN-400 and 

PXE Series 5 V Output 

7 GPIO3 / / Reserved 

8 GND / / Ground 

9 USART_TX_FP / / Reserved 

10 SYNC_RXRFLO I 3.3V RF LO synchronization 

11 SYNC_ADCCLK I 3.3V ADC clock synchronization 

12 SYNC_RXIFLO I 3.3V IF LO synchronization 

13 GND / / Ground 

14 REFCLK_OUT_FP O / Reference clock output for 10 

MHz standard clock signals 
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 All-New PXN Series Interface Description 

 

Figure 13 All-New PXN series instruments upper board interface description 

Table 14 All-New PXN Series Interface Description 

No Interface Name Description 

1 Power Button On/Off instrument 

2 Charging Port 

Instrument charging port, USB PD3.0 20 V 3.25 A, please 

connect the power supply according to the 

instrument's required operating voltage 

3 Micro HDMI For extended display 

4 USB3 USB interface: USB3 is USB 3.0 interface, USB1 and 

USB2 are USB 2.0 interface. This interface connects to 

external storage devices, USB keyboards, or mice. It 

can also be used to connect a driver-free Hub with an 

Ethernet port, allowing the instrument to be remotely 

5 USB2 

6 USB1 

7 Audio Output 
3.5mm headphone jack. Volume can be adjusted via the 

menu: "System" -> "Device" -> "Volume." 

8 Ethernet Port Gigabit ethernet port 

9 Multifunctional AUXIO 
For detailed description, please refer to the table 

below. 

10 Chargin Indicator 
Green blinking means charging, green solid means fully 

charged 

11 Analog IF Output 
MMCX (F), max. output power -25 dBm, output 

impedance 50 Ω 

12 Trigger Output 3.3V CMOS 

13 Trigger Input 
3.3V CMOS, high-impedance input, max trigger rate 

500 times/s 
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14 
Reference Clock Input / 

Output 

Input: MMCX (F), Amplitude ≥ 1.5 Vpp, Input Impedance 

330 Ω. 

Supports Sine, Square, Peak Clipping Sine 

Output: Reference clock output, output 100 MHz 

standard clock signal 

15 GNSS Antenna MMCX (F), amplitude ≥1.5 Vpp, input impedance 330 Ω 

16 RF Signal Input N (F), input impedance 50 Ω 

17 RF Signal Output N (F), output impedance 50 Ω 

Table 15 Pin description for AUXIO interface 8 (from left to right) 

Pin Name Direction Level Standard Meaning 

1 TRG_EXTIN I 3.3 V External Trigger Input 

2 REM_TRG_OUT / / Reserved 

3 RFM_TRG_IO3 O / Trigger Output 

4 GND / / Ground 

5 RFM_TRG_IO4 O 3.3 V 1PPS Output 

6 3V3D O / Power Output, 3.3 V Output 

7 USART1_RX / / Reserved 

8 GND / / Ground 

9 USART1_TX / / Reserved 

10 GPIO3 O 3.3V CMOS Programmable GPIO Output 

11 GPIO2 O 3.3V CMOS Programmable GPIO Output 

12 GPIO1 O 3.3V CMOS Programmable GPIO Output 

13 GND / / Ground 

14 GPIO0 O 3.3V CMOS Programmable GPIO Output 
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 PXZ Series 

Please refer to the following table for detailed information on each interface12. 

 

Figure 14 PXZ series instruments upper board interface description 

Table 16 PXZ Series Interface Description 

No Interface Name Description 

1 RF Signal Input PXE-200 Z: 2.92mm (M), input impedance 50 Ω 

PXN-400 Z: 2.4mm (M), input impedance 50 Ω 

2 Charging port Instrument charging port, USB PD (100W) 

3 External Antenna Input MMCX (F), amplitude ≥ 1.5 Vpp, input impedance 330 Ω 

4 Reference Clock Input MMCX (F), Amplitude ≥ 1.5 Vpp, Input Impedance 330 Ω. 

Supports Sine, Square, Peak Clipping Sine 

5 Multifunctional AUXIO For detailed description, please refer to the table below. 

6 loudness Increase/decrease instrument volume 

7 USB USB3.0 interface. Through this interface to connect the 

external expansion memory and USB keyboard, mouse; 

or connect the driver-free Hub with network port, 

through the network cable to connect to the PC, the PC 

to the instrument for remote control 

8 SD Card Slot Supports microSD, microSDHC or microSDXC memory 

cards for transferring data between the card and the 

instrument 

9 Charging Indicator Green flashing means charging, green always on means 

full. 

10 GNSS Indicator Blue indicates GNSS locked 

11 Audio Output 3.5mm headphone jack. Volume can be adjusted via the 

menu: "System" -> "Device" -> "Volume." 

12 Power Button Switching the instrument on/off 
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Table 17 Port 5 Multi-function AUXIO PIN Connector Description (A1-A12 shown from left to 

right B1-B12 shown from right to left) 

Pin Name Direction Level Standard Meaning 

A1/A12 GND / / Ground 

A2 to A3 

A5 to A8 

A10 to A11 

/ / / Reserved 

A4/A9 VBUS OUT O / Power supply 5 V output 

B1/B12 GND / / Ground 

B2 REFCLK_OUT O / Reference clock output for 10 

MHz standard clock signals 

B3 TRG_IO2 O 3.3 V Trigger output, 3.3V CMOS 

B4/B9 VBUS OUT O / Power supply 5 V output 

B10 

B5-B8 

/ / / Reserved 

B11 EXT_TRGIN I 3.3 V External trigger input, 3.3V 

CMOS input impedance is 

high resistance, maximum 

frequency response 500 

times/s. 
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6. GNSS Application Instructions 

This chapter describes how to identify the version of the accompanying GNSS module and how 

to obtain real-time positioning data using either the internal or an external GNSS module. 

6.1 Internal GNSS Option 

 Version Information 

The internal GNSS module refers to the company’s in-house developed GNSS module, which 

is available in two versions: Version A and Version B. Version A is the earlier version, while 

Version B is the newer one. The two versions are functionally identical and differ only in their 

power supply methods. Please identify the module version in use according to the appearance 

diagrams below, and strictly follow the corresponding section for connection and operation to 

ensure stable operation of the GNSS module. 

 

Figure 15 GNSS module version A 

appearance 

 

Figure 16 GNSS module version B 

appearance 

 Description of GNSS Options 

The following accessories are for SA series instruments. NX/PX/SAN series instruments have 

built-in GNSS modules, so to use the GNSS function, you only need to connect the antenna, 

and do not need to connect the accessories listed below. 

Note: 1PPS and 10MHz clock signal outputs from GNSS are not recommended when the GNSS 

module is unlocked. 
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Version A standard GNSS 

module 

 

Version A high-precision GNSS 
module 

 
Version A high-quality GNSS 

module 

 

Version B standard GNSS 

module 

 

Version B high-precision GNSS 

module 

 
Version B high-quality GNSS 

module 

 
Ribbon Cable 

(Connection of external GNSS 
modules and SA series 

instruments) 

 
MMCX-to-SMA Cable 

(Connection of antenna and 
GNSS module) 

 
AUXIO Multi-Function to Type-C 

Adapter 
(Connection of SAM/SAN series 

and rows of wires) 

 

MCX-to-MMCX Cable 
(Connection of the reference input of the 

SAM/SAN instrument and the reference output of 
the GNSS module) 

 

MMCX Cable 
(Connection of the reference input of the 

SAE/SAN-400 instrument and the reference 
output of the GNSS module) 
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 Interface Description 

  

  

  

1 External GNSS Antenna Interface 6 Reserved Interface 

2 External Reference Input Interface 7 Auxiliary Power Supply Type-C 

Interface (only applicable to high-

quality GNSS modules) 

3 External Trigger Input Interface 8 AUXIO Multi-Function Interface 

(Trigger Input/Output) 

4 Trigger Output Interface 9 Analog Intermediate Frequency (IF) 

Input Interface (for SAE/SAN-400 

devices) 

5 Analog Intermediate Frequency (IF) 

Output Interface (for SAE/SAN-

400 devices) 

10 10MHz Reference Clock Output for 

High-Quality GNSS Modules 
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6.2 External GNSS Module 

An external GNSS module refers to a GNSS module produced by a third-party manufacturer 

that supports serial communication. Users can connect the serial output of the module to the 

instrument PC via a USB-to-serial cable. After the connection is established, the module 

communicates with the PC, is recognized by the system as a virtual serial port, and the GNSS 

data stream is parsed. Once a successful lock is achieved, GNSS information can be viewed in 

the software. 

6.3 Connection of Internal GNSS Module 

 SAE/SAN-400 Series 

The operating steps for connecting Version A GNSS option to the SAE/SAN-400 series 

instrument are as follows: 

1. Instrument connection: Instrument No. 5 AUXIO interface -> GNSS module No. 8 AUXIO 

interface (with the ribbon cable), GNSS module indicator light blinking that is connected 

successfully. 

2. External GNSS antenna connection: antenna -> GNSS module No. 1 interface (with MMCX 

to SMA cable), antenna receiving surface towards the unobstructed sky. 

3. GNSS external power supply (high-quality modules only): use a Type-C cable to connect 

the GNSS module's No. 7 interface to the power adapter and plug it into an outlet. 

4. Reference clock connection (high-quality module only): MMCX connector No. 4 of the 

instrument -> MMCX connector No. 10 of the GNSS module (with dual-head MMCX cable). 

 

Figure 17 SAE/SAN-400 module connection with version A GNSS module diagram 

The operating steps for connecting Version B GNSS option to the SAE/SAN-400 series 

instrument are as follows: 

1. Complete the instrument connection and external GNSS antenna connection following 

Steps 1 and 2 of Version A; 

2. GNSS External Power Supply: Use a Type-C cable to connect the GNSS module's Interface 

7 to the power adapter, and plug it into the socket; 
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3. Reference Clock Connection (for High-Quality Modules Only): Instrument MMXC Interface 

4 -> GNSS Module MMCX Inteface 10 (using a dual-head MMCX cable). 

 

 

Figure 18 SAE/SEN-400 Module Connection Diagram for Version B GNSS Module 

 SAM/SAN Series 

The operating steps for connecting Version A GNSS option to the SAM/SAN series instrument 

are as follows: 

1. Instrument Connection: Instrument No.6 AUXIO interface -> GNSS module No.8 AUXIO 

interface (with AUXIO to Type-C and Ribbon Cable), GNSS module indicator light blinks 

that the connection is successful. 

2. External GNSS antenna connection: antenna -> GNSS module 1 interface (with MMCX to 

SMA cable), antenna receiving surface towards the unobstructed sky. 

3. GNSS external power supply (high-quality module only): Use a Type-C cable to connect the 

GNSS module's No. 7 connector to the power adapter and plug it into an outlet. 

4. Reference clock connection (high quality module only): MCX connector No. 4 of the 

instrument -> MMCX connector No. 10 of the GNSS module (with MCX to MMCX cable). 

 

Figure 19 SAN/SAM module connection with version A GNSS module diagram 
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The operating steps for connecting Version B GNSS option to the SAN/SAM series instrument 

are as follows: 

1. Complete the instrument connection and external GNSS antenna connection following 

Steps 1 and 2 of version A; 

2. GNSS External Power Supply: Use a Type-C cable to connect the GNSS module's Interface 

7 to the power adapter, and plug it into the socket;  

3. Reference Clock Connection (for High-Quality Modules Only): Instrument MCX Interface 

3 -> GNSS Module MMCX Inteface 10 (using an MCX-to-MMCX cable). 

 

Figure 20 SAN/SAM Module Connection Diagram for Version B GNSS Module 

 All-New SAN Series 

The all-new SAN series instruments are equipped with a built-in GNSS module. During use, an 

external GNSS antenna (with the receiving surface facing an unobstructed sky) should be 

connected to interface 2 of the instrument. 

 NX Series 

The NX series instruments have built-in GNSS modules. To use them, you only need to connect 

the antenna, and the receiving side of the antenna is facing to the unobstructed sky. The 

procedure is as follows: 

1. NXE/NXN-400 series: Antenna -> Instrument 4 GA interface (with MMCX to SMA cable). 

2. NXM/NXN series: Antenna -> Instrument 5 GA interface (with MMCX to SMA cable). 

 PX Series 

1. PXE-90/PXE-200/PXN-400: Instruments have built-in GNSS modules. To use them, you 

need to connect an external GNSS antenna (with the receiving side facing the 

unobstructed sky) to the instrument's No. 14 GA interface. 

2. PXN-45/PXN-60/PXN-90: Instruments have built-in GNSS modules. To use them, you need 

to connect an external GNSS antenna (with the receiving side facing the unobstructed sky) 

to the instrument's No. 14 GA interface. 
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 PXZ Series 

PXZ series instruments have built-in GNSS module, when using the external GNSS antenna 

(receiving side towards the unobstructed sky) through the MMCX to SMA cable connected to 

the instrument's No. 3 ANT port. 

6.4 Connection of External GNSS Module 

 SA / NX Series 

Connect the instrument to the PC via the USB 3.0 interface, and connect the external GNSS 

module to the PC’s USB interface using a USB-to-serial cable. 

 PX Series 

External GNSS module -> Instrument Interface 4 (using a USB-to-serial cable). 

 PXN Series 

External GNSS module -> Instrument Interface 5 (using a USB-to-serial cable). 

 PXZ Series 

External GNSS module -> Instrument Interface 7 (using a USB-to-serial cable).  
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7. Using the Accompanying Trigger Board 

This chapter explains how to connect and use the accompanying trigger board on SA, NX, and 

PX series instruments, including trigger input/output and 10 MHz reference clock output 

functions. 

7.1 Interface Overview 

 Introduction to the Trigger Board for SA/NX/PX Series 

 

Figure 21 SA/NX/PX Series Accompanying Trigger Board Interface Diagram 

Table 18 SA/NX/PX Series Interface Description 

Pin Name Direction Level Standard Meaning 

1 TRGIO1 I 3.3V Trigger Input 

2 TRGIO2 / / Reserved 

3 TRGO/IO3 O 3.3V Trigger Out 

4 LFADC / / Reserved 

5 LFADC / / Reserved 

6 G-3V3 O / Power Output, 3.3V 

7 G-U9TX / / Reserved 

8 G-DLREF / / Reserved 

9 REFOUT O / Reference clock output for 

10 MHz standard clock 

signals 

10 AUXIO / / Multi-Function Port 
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11 G-U9RX / / Reserved 

12 G-RFLO / / Reserved 

13 G-IFLO / / Reserved 

 Introduction to the Trigger Board Interfaces for the PXZ Series 

 

Figure 22 Description of the Trigger Board Interfaces for the PXZ Series 

Table 19 Description of the Trigger Board Interfaces for the PXZ Series 

Pin Interface Name Description 

1 Type-C 

multifunction port 

Connected to the multifunction AUXIO port of the PXZ 

Series. 

2 14-pin 

multifunction port 

For a detailed description, please refer to Table below. 

Table 20 Description of the 14-pin Multifunction Port (Orientation from Left to Right) 

Pin Name Direction Level Standard Meaning 

1 TRG_IO1 I 3.3V External Trigger Input 

2 TRG_IO2 / / Reserved 

3 TRGO/IO3 O 3.3V Trigger Output 

4 GND / / Ground 

5 UART_IT / / Reserved 

6 3V3DIN O / Power Output, 3.3V 

7 UART_RX / / Reserved 

8 GND / / Ground 

9 UART_TX / / Reserved 

10 NC / / Reserved 

11 NC / / Reserved 

12 NC / / Reserved 
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13 GND / / Ground 

14 REFOUT O / Reference clock output for 

10 MHz standard clock 

signals 

7.2 Connection Diagram 

 SAE/SAN-400 Series 

1. Connect the ribbon cable: Instrument AUXIO interface No.5 -> 14-pin ribbon cable. 

2. Connect the trigger board: 14-pin ribbon cable -> Trigger board multifunction port No.10. 

 

Figure 23 SAE and SAN-400 Series Instruments Connection to External Trigger Module 

 SAN/SAM Series 

1. Connect AXUIO multifunction to Type-C: Instrument AUXIO interface No.6 -> AUXIO to 

Type-C adapter; 

2. Connect the ribbon cable: AUXIO to Type-C adapter -> 14-pin ribbon cable; 

3. Connect the trigger board: 14-pin ribbon cable -> Trigger board multifunction port No.10. 

 

Figure 24 SAN/SAM Series Instruments Connection to External Trigger 

 All-New SAN Series 

1. Connect the ribbon cable: Instrument AUXIO Interface 8 -> 14-pin ribbon cable 

2. Connect the trigger board: 14-pin ribbon cable -> Trigger Board multifunction Port 10 
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Figure 25 Connection Diagram of SAN Series with the Companion Trigger Board 

 NX Series 

The trigger input/output interface of NX series instruments is located at the MMCX (F) port on 

the instrument and is not integrated into the AUXIO port. The 10 MHz reference clock can be 

output via the multifunction AUXIO port with the trigger board. The specific connection method 

is as follows: 

1. NXE/NXN-400 series: Instrument AUXIO interface No.3 -> 14-pin ribbon cable -> Trigger 

board multifunction port No.10; 

2. NXM/NXN series: Instrument AUXIO interface No.9 ->  14-pin ribbon cable -> Trigger 

board multifunction port No.10. 

 PX Series 

The trigger input/output of PX series instruments is located at the MMCX (F) port on the 

instrument and is not integrated into the AUXIO port. The 10 MHz reference clock can be output 

via the multifunction AUXIO port with the trigger board. The connection is as follows: 

Instrument AUXIO interface No.8 -> 14-pin ribbon cable -> Trigger board multifunction port 

No.10. 

 All-New PXN Series 

The new PXN series instruments can output a 100 MHz reference clock via the multifunction 

AUXIO port when connected to a trigger board. The specific connection is as follows: 

Instrument AUXIO interface No.9 -> 14-pin ribbon cable -> Trigger board multifunction port 

No.10. 

 PXZ Series 

Connect AUXIO multi-function to Type-C: Instrument AUXIO Interface 5 -> Trigger Board 

multifunction Port 1. 
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8. Reference Clock Input and Output 

This chapter describes how to use the reference clock input and output function on SA, NX, and 

PX series instruments. 

8.1 Reference Clock Input 

 Hardware Connection 

1. SAN/SAM Series: Reference clock source -> Instrument MCX (F) Interface 3. 

2. SAE/SAN-400 Series: Reference clock source -> Instrument MMCX (F) Interface 4. 

3. All-New SAN Series: Reference clock source -> Instrument MMCX (F) Interface 5. 

4. NXN/NXM Series: Reference clock source -> Instrument MCX (F) Interface 1. 

5. NXE/NXN-400 Series: Reference clock source -> Instrument MMCX (F) Interface 7. 

6. PX Series: Reference clock source -> Instrument MMCX (F) Interface 13. 

7. All-New PXN Series: Reference clock source -> Instrument MMCX (F) Interface 14. 

8. PXZ Series: Reference clock source -> Instrument MMCX (F) Interface 4. 

 Software Operation 

In the main settings area of the software, click "System" -> "RefCLKSource", select "External", 

and set the "RefCLKFreq" to 10 MHz. 

 

Figure 26 Setting the External Reference Clock Source 
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8.2 Reference Clock Output 

 Hardware Connection 

1. SAN/SAM Series: No reference clock output function. 

2. SAE/SAN-400 Series: Connect the instrument to the companion trigger board; Trigger 

Board MMCX (F) Interface 9 -> Instrument requiring the reference clock.  

3. All-New SAN Series: Instrument MMCX (F) Interface 6 -> Instrument requiring the reference 

clock. 

4. NX Series: Connect the instrument to the companion trigger board; Trigger Board MMCX 

(F) Interface 9 -> Instrument requiring the reference clock. 

5. PX Series: Connect the instrument to the companion trigger board; Trigger Board MMCX (F) 

Interface 9 -> Instrument requiring the reference clock.  

6. All-New PXN Series: Connect the instrument to the companion trigger board; Trigger Board 

MMCX (F) Interface 14 -> Instrument requiring the reference clock.  

7. PXZ Series: Connect the instrument to the companion trigger board; Trigger Board 14-pin 

Multi-function Interface 2 -> Other series companion trigger board (via 14-pin ribbon cable); 

Other series companion trigger board MMCX( F) Interface 9 -> Instrument requiring the 

reference clock. 

 Software Operation 

In the main settings area of the software, click "System" and enable "RefCLKOut". 

 

Figure 27 Setting the Reference Clock Output 
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9. Analog IF output 

9.1 Output Intermediate Frequency Signal 

1. Connect the signal generator to the instrument's RF input interface, with the signal 

generator outputting a 1 GHz, 0 dBm signal; 

2. Switch the software to Receiver/IQ Stream mode, ensuring that the instrument outputs a 

stable intermediate frequency (IF) signal; 

3. Output the IF signal generated by the instrument to other measuring instruments for 

viewing through the following interface. 

▪ SAE/SAN-400 Series: Interface 2 

▪ All-New SAN Series: Interface 7 

▪ NXE/NXN-400 Series: Interface 9 

▪ PX Series: Interface 10 

▪ All-New PXN Series: Interface 11 

9.2 Viewing the IF Signal 

1. The frequency of the simulated intermediate frequency output signal is between about 

307.2 MHz ± 50 MHz, with a maximum output power of -25 dBm and an output impedance 

of 50 Ω. The center frequency of the simulated IF output for each instrument can be found 

in the IF calibration file within the "/bin/CalFile" folder of the instrument's software directory; 

 

Figure 28 View the simulated intermediate frequency output frequency points 

2. Set the "Center Frequency" of the measuring instrument to 311 MHz (refer to the 

corresponding calibration file for the specific value), and keep the other parameters at their 

default settings. Then, view the intermediate frequency output. 
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Figure 29 View the intermediate frequency output signal. 
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10. GPIO Usage Instructions 

This chapter describes how to connect the EIO expansion board to the all-new SAN series and 

all-new PXN series instruments and control the output levels of the various GPIO interfaces. 

10.1 EIO Expansion Board Interface Description 

 

Figure 30 EIO Expansion Board Interface Description 

Table 21 Pin Description of the EIO Expansion Board Interface 

Pin Description 

1 GPIO0 

2 GPIO2 

3 GPIO4 

4 GPIO6 

5 GND 

6 GPIO1 

7 GPIO3 

8 GPIO5 

9 GPIO7 

10.2 EIO Expansion Board Connection 

All-New SAN Series Instrument: EIO Expansion Board 14-pin Interface -> All-New SAN Series 

Instrument AUXIO Interface 8. After connection, click "System" -> "GPIO" in the software menu 

bar to control the output levels of the different GPIO interfaces. 

All-New PXN Series Instrument: EIO Expansion Board 14-pin Interface -> All-New SAN Series 

Instrument AUXIO Interface 9. After connection, click "System" -> "GPIO" in the software menu 

bar to control the output levels of the different GPIO interfaces. 

 

  



 

Spectrum Analyzer Quick Start Guide 41 

 

11. Modify the IP address of the NX-Series 
instrument 

Go to the official website of HAROGIC (https://www.harogic.com/setdeviceipaddr-2/) to 

download and extract the "SetDeviceIPaddr.zip "folder to your desktop or other directory. 

11.1 Obtaining NX-Series Instrument IP Addresses 

1. Default IP address: "192.168.1.100" (not modifiable), "192.168.3.100" (modifiable). 

2. Instruments through the direct connection or access to the router, to ensure that and the 

host computer in the same network segment. 

3. Run "SetDeviceIPaddr\SetDevicelPaddr.exe" to check the IP address of the instrument. 

11.2 Modifying NX-Series Instrument IP Addresses 

 Notes on IP modification 

1. To ensure that the IP of the receiver network card and the host computer other non-physical 

connection of the network card's IP address is in a different network segment, in order to 

avoid network conflicts. 

2. IP address cannot end with ".0", ".1" or ".255", these addresses have a special purpose in the 

network (such as network address, broadcast address or gateway address), the use of 

them may lead to communication anomaly ), and their use may lead to communication 

anomalies. 

 IP Modification Procedure 

Run "SetDeviceIPaddr\SetDevicelPaddr.exe". 

1. Single instrument 

▪ Enter the IP address (in standard format, e.g., 192.168.3.101) 

▪ Enter the subnet mask (CIDR format, e.g. 255.255.255.0) 

▪ Press the Enter key to execute the modification, and the prompt "Change ip address 

successfully" indicates success 

 

Figure 31 Single NX Instrument Modification IP 

https://www.harogic.com/setdeviceipaddr-2/
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2. Multiple instruments 

▪ Enter the instrument numbers in sequence (each instrument corresponds to a unique 

Device Number, take the instrument with UID 33325110003e0029 as an example) 

▪ Enter the IP address and subnet mask (in the same format as above) 

▪ Press the Enter key to execute the modification, and the prompt "Change ip address 

successfully" indicates success 

 

Figure 32 IP modification for multiple NX instruments 
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12. PX Remote Control Guide 

12.1 Network port direct connection 

1. Connect the driverless docking station with network port to the USB 3.0 interface (USB3) 

on the upper panel of the instrument, and connect it to the network port of the computer 

or embedded instrument via a network cable. Note: USB1 and USB2 are USB 2.0 interfaces, 

it is recommended to use the USB3 interface in preference for better performance. 

 

Figure 33 External drive-free docking station with network port 

2. Exit the current host computer software, enter the PC "Settings -> Network and Internet -> 

Properties", manually configure the IPv4 address (such as "192.168.1.2") and subnet mask 

("255.255.255.0"), ensure that the same network segment as the instrument IP 

("192.168.1.100"), and the instrument IP ("192.168.1.100"). "255.255.255.0"), make sure that it is 

in the same network segment as the instrument IP ("192.168.1.100"). 

 

Figure 34 Configuring IP Addresses and Subnet Masks 
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3. Through the cmd execution "ping 192.168.1.100" to verify network connectivity. 

 

Figure 35 Test instrument network connectivity (ping command) 

4. Double-click to open the PC host software directory "configuration\Settings.ini" file, set 

Interface = ETH; 

5. From the userdata folder on the desktop of the instrument, enter the "/bin/CalFile" path of 

the software to get the calibration file and save it to the "\bin/CalFile" directory of the 

corresponding software on the PC. 

 

Figure 36 Obtaining Instrument Calibration Documentation 

6. Start the executable programme in the "/bin" folder in the software directory of the PC to 

achieve remote control of the PX series instruments. 

    Note: The instrument and the PC software cannot be switched on at the same time. 
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Figure 37 Direct Ethernet Connection for Remote Control of PX Instruments 

12.2 LAN connectivity 

1. Connect the driver-free docking station with network port to the USB 3.0 interface (USB3) 

on the upper panel of the instrument, and connect it to the network port of the router 

through the network cable. Note: USB1 and USB2 are USB 2.0 ports, it is recommended to 

use the USB3 port in preference for better performance; 

 

Figure 38 Connecting the Router to the Instrument 

2. Click the menu bar "File" -> "Exit", exit the software interface in the instrument; 

3. Click "userdata" -> "Tools" -> "Open Current Folder in Terminal"; 
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Figure 39 Open terminal 

4. In the terminal, type "ifconfig" query the current router to the IP address assigned to the 

instrument, in this case, the IP address is "192.168.31.55"; 

 

Figure 40 Query the dynamic IP acquired by the instrument 

5. Connect the PC to the same router via Wi-Fi to ensure that it is on the same LAN as the 

instrument. Double-click to open the "configuration\Settings.ini" file in the directory of the 

PC host software, set Interface = ETH, Address = "192.168.31.55 " 

6. For the next steps, please refer to step 5 to step 6 of the chapter on the Network port direct 

connection. 

 

Figure 41 Remote control of PX instruments by LAN 
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12.3 OTG Connection 

1. Connect the instrument's USB 3.0 interface (USB3) to the host computer's USB port using a 

USB cable; 

2. Click "File" -> "Exit" in the menu bar to return to the instrument's desktop. Click the "OTG" 

icon on the desktop, and after the window pops up, observe the content of the window: 

▪ If the window displays "OTG is enabled," manually restart the instrument 

▪ If "OTG is disabled" appears, close the pop-up window, click the "OTG" icon again, and then 

manually restart the instrument 

 

Figure 42 Check the OTG startup status 

3. Refer to Steps 2 to 6 in the Network port direct connection section to configure the network 

and remotely control the instrument. 
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